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2.1

Welcome to ArcCadastre

Welcome to Getting Started with ArcCadastre.  
ArcCadastre is a unique, specially developed 
”all-in-one” software package for collecting, 
managing, processing and presenting geograph-
ic, cadastral and survey information.
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Welcome to  Getting Started with ArcCa-
dastre.  ArcCadastre is a unique, specially 
developed ”all-in-one” software package 
for collecting, managing, processing and 
presenting geographic, cadastral and sur-
vey information.

Getting Started is a short introduc-
tion to ArcCadastre for both first-time users of the 
program and for persons who have no previous ex-
perience of this type of software.  Before installing 
or starting to use the program, we recommend that 
you take time to carefully read this handbook.  It is 
designed to help you to quickly get started and un-
derstand some of the most important basic concepts 
in ArcCadastre, so that you can get the best out 
of the program.  After you have read through the 
handbook you should have a general understanding 
of the structure and functionality of the program 
and be able to start using it with your own data. 

The handbook is in three parts. 

	 Part 1 
Familiarizing yourself with ArcCadastre - is a de-
scription of the general structure of the program 
and explains how you can get help to use it. 

	 Part 2 
In - ArcCadastre in detail - there are short descrip-
tions of some important ArcCadastre concepts. 

	 Part 3 
Getting started with ArcCadastre - which contains 
the ”QuickStart” tutorials.  Going systematically 
through these tutorials is the best way to learn how 
to use and understand the fundamentals of Arc-

Cadastre.  
It will take you about four hours to read 

through this booklet and do the exercises in Quick-
Start, but it will be time well spent.
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Familiarizing yourselves 
with ArcCadastre

•  What is ArcCadastre ?    
     The technical platform
     What can you do with ArcCadastre?  

•  Getting help
     Getting started with ArcCadastre
     Help system
     Support 
     More about ArcCadastre	

ArcCadastre was initially developed as a 
replacement for Lantmäteriet’s well-proven 
cadastral and mapping software AutoKa-
PC.  ArcCadastre has been designed as a 
software package for worldwide use and can 
be supplied with country-adapted customi-
zation.

In this chapter
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What is ArcCadastre?

ArcCadastre is a replacement for Lantmäteriet’s 
well-proven cadastral and mapping software  
AutoKa-PC, which was introduced about ten years 
ago.  During this period both our research and 
development staff and our user community have 
accumulated a wealth of competence and experience 
in developing and using this type of software.  This 
knowledge base has been used when developing 
ArcCadastre.  

Lantmäteriet has developed ArcCadastre in 
close cooperation with  the international, market-
leading GIS company ESRI Inc. 

Particular attention has been given to analytical 
functionality as well as to data capture and compu-
tational functionality.  Our combined experience of 
software development and maintenance is a guaran-
tee that users of ArcCadastre will not run the risk of 
purchasing an incomplete product with a short life-
time. ArcCadastre has been designed as a software 
package for worldwide use  and can be supplied 
with country-adapted customization.
Because of ArcCadastre’s comprehensive function-
ality, you can use the program in unified produc-
tion lines ranging from data collection - including 
field survey data - processing, presentation of dif-
ferent maps and documents, through to the storage 
of the data in an object-oriented database environ-
ment from which other applications and systems 
can retrieve information for processing in different 
ways.  Work processes can be designed as work-
flows.

Thanks to the technology that has been chosen 
for the development of ArcCadastre, you can easily 
customize and build systems to satisfy your own 
special needs in a variety of ways.  The various func-
tionality that may be needed in different countries, 
or by different user groups to satisfy the require-
ments of local legislation and regulations, can be 
easily added to ArcCadastre.

The technical platform
Lantmäteriet is the owner and has been responsible 
for the overall design and development of ArcCa-
dastre.  

The development strategy that was adopted in-
volved the use of the latest industry standard prod-
ucts such as C++ compilers and software creation 
using Component Object Model (COM) methods 
to facilitate maintenance of ArcCadastre and, at the 
same time, be a sound foundation for future devel-
opment of the software.

You can find more information and explanation of 
specific ArcCadastre concepts in Part 2 ArcCadas-
tre in detail.

Lantmäteriet development

Safe Software FME

ESRI Survey Analyst

ESRI ArcGIS
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What can you do with ArcCadastre ? 
ArcCadastre has been designed to satisfy a wide 
range of users and uses including:

	 Local authority survey and mapping organiza-	
	 tions.

	 Real property formation.

	 The production of cadastral index maps.

	 Public utilities mapping.

	 Surveying and mapping companies.

	 Property management groups.

	 Property tax assessment and property valuation.

	 National, regional and local planners.

What can you do with ArcCadastre Sverige ?
ArcCadastre Sverige is the Swedish version of Arc-
Cadastre and has been produced for the Swedish 
market, primarily for use by Lantmäteriet’s and  
Swedish municipal cadastral authorities. ArcCa-
dastre Sverige comprises the ”core” version of Arc-
Cadastre specially customized for use with Swedish 
cadastral applications and management routines. 
ArcCadastre Sverige has been designed to support 
the following activities:

	 Producing and revising large-scale municipal 	
	 maps.

	 Producing site and plot maps.

	 Producing simple cadastral maps.

	 A prototype for a planning process support.  

ArcCadastre contains an object-oriented model that 
supports these activities. 

In ArcCadastre Sverige, all text is in Swedeish 
except the ArcCadastre Desktop Help. 
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Getting help

You can get help when you are working with Arc-
Cadastre in several different ways. 

Getting started with ArcCadastre
This handbook will give you a good overview intro-
duction to ArcCadastre. Some of the most impor-
tant ArcCadastre concepts are explained and there 
is a number of QuickStart exercises. 

Help system
ArcCadastre includes a comprehensive on-line Help 
system. When you want to learn how to perform 
a specific task or need more information about a 
related concept, you can always use the online Help 
system. You can access the Help system in a number 
of ways:

	 In the application window, using ToolTips, sta-	
	 tus bar Help, and the What’s This? button.

	 In dialogs. 

	 In the Help viewer window, using the Contents, 	
	 Index, Search and Favorites tabs.

You will find more about the Help system in Part 3. 

Support
In addition to the comprehensive on-line Help sys-
tem in the program itself, you can also get help from 
the support organization that has been built up 
around ArcCadastre.  For more information about 
getting help, contact your software dealer.

More about ArcCadastre 
You can find the latest information about ArcCa-
dastre at  www.arccadastre.com

Help!



ArcCadastre in detail

•  ArcCadastre - General information    
     ArcCadastre
     ArcCadastre/FileManager
     Workflow Editor 
     Attribute Form Editor

•  ArcCadastre - Concepts
     Job
     Workflow
     Plotting styles
     Map templates 
     Geodatabases
     Data models

You may encounter several new concepts in 
ArcCadastre. In this chapter there are short 
explanations of some of the most important 
of them, together with descriptions of some 
parts of the program. You can find more de-
tailed information in the ArcCadastre Help 
system. 

In this chapter

2
     Survey databases
     Survey and computation
     Import and export

•  COM based software
     Customization
     Interacting with other software
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If ArcCadastre is started, you can also start ArcCa-
dastre/FileManager from ArcCadastre by clicking 
the Launch ArcCadastre/FileManager button on 
the Standard toolbar.   

Workflow Editor
In ArcCadastre the Workflow Editor is used to cre-
ate and edit workflows.  In the Workflow Editor 
you work with graphical visualization of your work-
flows. The ArcCadastre Workflow editor follows the 

UML standards and completed workflows are saved 
as XML files.  The Workflow Editor is mainly in-
tended for use by customizers and not by end users.
The Workflow Editor is launched from the Start 
button on the Windows taskbar.

1 	 From Windows Start button, select the pro-
gram group ArcCadastre. 
2 	 Click Workflow Editor.

Attribute Form Editor
The Attribute Form Editor is used to customize 
standard forms for classes in a geodatabase. It is for 
instance possible to add, change or delete fields. 

1 	 From Windows Start button, select the pro-
gram group ArcCadastre.
2 	 Click Attribute Form Editor.

ArcCadastre - General information
ArcCadastre
ArcCadastre is an all-in-one program package 
that has been built on the latest and most modern 
platforms. With ArcCadastre you already have to-
morrow’s solutions today.  Lantmäteriet owns the 
ArcCadastre copyright although the program has 
been developed in close cooperation with ESRI Inc. 

ArcCadastre/FileManager
ArcCadastre/FileManager is an integral part of Arc-
Cadastre and functions in a similar way to Explorer 
in Microsoft Windows. In ArcCadastre/FileMan-
ager you can administer your data and you can also:

	 Create new personal geodatabases.

	 Create and administer survey databases.

	 Rapidly check and administer geographic data 	
	 and tables.

	 Create connection to common (multi-user) 	
	 geodatabases.

	 Create and edit metadata.

	 Search for data by searching in metadata or by 	
	 reference to geographic position.

You can launch ArcCadastre/FileManager from the 
Start button on the Windows taskbar.

1 	 From Windows Start button, select the pro-	
	 gram group ArcCadastre. 
2 	 Click ArcCadastre/FileManager. 
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ArcCadastre - Concepts
Job
In most organizations the use of data is often strictly 
regulated by laws, regulations and instructions and 
its processing must follow a workflow based on set 
processes and routines.  This is typically the case 
for real property formation where, in addition, a 
number of documents are generated and sent to the 
involved parties.  Similarly, for cartographic pur-
poses, there may be a need to create a number of ob-
jects in, or make changes to, a geographic database 
involving input and output files and large volumes of 
data.  To keep track of processes and for quality as-
surance there is a need for organization and control 
of the workflow. ArcCadastre supports the handling 
of these types of processes through the Job concept.

In ArcCadastre a Job is the basic mechanism for 
handling work processes. All work in ArcCadastre is 
carried out within the framework of a Job.
A Job has the following characteristics:

	 The function of a Job is to organize and keep 	
	 track of all relevant information and settings 	
	 that belong to it.  These can include program 	
	 settings, data sources and features in geodata-	
	 bases, as well as references to documents be-	
	 longing to it.

	 In the cadastral process Jobs are used to manage 	
	 the legal requirements so that, for example,  
	 a process will be automatically suspended where 	
	 legal approval is required before it can proceed.

	 A Job has a lifespan during which it supports 	
	 the overall handling of all items affected by it.

	 Jobs are created from a Job template and are 	
	 saved with a unique designation (ID) in a Job 	
	 database.

	 A Job has a workflow, see Workflow below.

	 A Job has at least one map document.

	 Access to a Job is regulated by the overall access 	
	 rights system. This facility can be used to res-	
	 trict access to a complete Job, or parts of a Job, 	
	 to specified users.

	 A Job can have a relationship to other Jobs,  	
	 Sub Jobs. For example it may not be possible 	
	 to start a Job until it has received input data 	
	 from another Job.

	 The settings for a Job can be viewed by click- 
	 ing on the Job tab in the table of contents. 

Job template

Settings

GUI

File

Macro

Wizards
Menus

Toolbars

Plotting-
Styles

Flash
maps

Data-
base

Access

Map

Raster

Work-
flow

Job
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Workflow
A workflow is an implementation plan that guides 
you through a Job.  With the help of a workflow 
you can monitor the progress of your work.  The 
simplest form of workflow is a checklist in which 
the user must check (tick) check boxes as the dif-
ferent stages in the process are completed. Complex 
workflows can also be created in ArcCadastre. 
An example of a complex workflow is a process in 
which some of the operations must be carried out in 
a given sequence or in a specific way before the proc-
ess can continue.  A workflow can be extended with 
plug-ins written in any COM-compliant language, 
such as Visual Basic, through which steps in the 
process can be automated.  COM-compliant lan-
guage also makes it possible to communicate with 
other external applications.

By using a workflow, parts of a procedure that 
contain the same elements, and which are frequent-
ly repeated, can be rationalized.  With a workflow it 
is easy to monitor that legally defined processes and 
routines are followed.

Workflows are normally created by a specialist 
customizers with the help of the Workflow Editor, 
which is included in the ArcCadastre package. The 
editor stores the information about the workflow in 
XML file format.

The editor is a graphical tool that can also sim-
ulate, generate new code and update existing code if 
the diagram is changed.

Plotting styles
ArcCadastre uses plotting styles to define how the 
presentation of data is to be done both on your 
screen and printer.  A plotting style consists of a 
number of layer names with descriptions of how 
each layer is to be drawn.  Plotting descriptions can 
be used for drawing points, lines, polygons or text. 
As a plotting style does not contain the data sources 
for the layers, the same plotting style can be used for 
different databases, which contain the same type of 
features.  

One of the principal advantages of using plot-
ting styles is that you can easily change the appear-
ance of a map simply by changing the plotting style.  
For example, you can use one plotting style for edit-
ing a map and another for presenting it.
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In addition to information about the different lay-
ers, a plotting style contains information about their 
drawing order, the reference scale and more. You 
can easily edit a plotting style description for a layer 
and copy a plotting description from one plotting 
style to another. 

ArcCadastre comes with several predefined 
plotting styles, but you can also create your own.

Map templates 
A map template is always the starting point for 
making a map. A typical map template contains 
one or several predefined layouts that arrange an 
assortment of map elements such as titles, scale 
bars, North arrow, legend and text fields. It is also 
possible to add tables, OLE documents, logotypes, 
etc. You can produce a map by simply adding geo-
graphic data. A template can be used to produce a 
single map or a series of maps that have the same 
appearance. If a map product always contains layers 
from a specific dataset these layers can be included 
in the template. All users in an organization can 
share templates.

The ArcCadastre package contains several dif-
ferent map templates with different layouts and for 
different applications. You can easily modify these 
templates by adding new map elements, changing 
existing ones or deleting old. You can also create 
your own templates.

Geodatabases
In ArcCadastre data is stored in geodatabases. A 
geodatabase is a relational or object-relational data-
base that has been enhanced by adding geographic 
data storage and referential integrity constraints. 
Geodatabases on any relational database manager 
supported by ArcCadastre operate identically. This 
facilitates the use of a single database manager 
throughout a whole organization.

In ArcCadastre there are two types of databas-
es: Personal and Common (multi-user).

Personal databases
Several users can import and export simultaneously 
but only one person at a time can edit features in 
the database. Storage is done in Microsoft Access 
format, in a file-based database or in a personal 
ArcSDE database. You can create and work with a 
personal database in ArcCadastre without the need 
for any other software.

Common (multi-user) databases
Data in common databases can be imported, ex-
ported and changed by several users simultaneously. 
This requires a database environment with a data-
base manager. A Common database can be used 
with ArcCadastre, but requires the use of ArcSDE 
for making changes and handling schemas.

ArcCadastre comes with support for personal 
geodatabases. In addition ArcCadastre supports the 
following database managers via ArcSDE:

	 Microsoft SQL-Server

	 Oracle and Oracle Spatial

	 IBM DB2

	 Informix
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Data models
Three different data models come with ArcCadas-
tre: the model for ArcCadastre Sverige, the Basic 
Model and the AutoKa Model.

The data model for ArcCadastre Sverige is an 
object-oriented model designed for use by Swedish 
municipal cadastral authorities and within the four 
main cadastral processes that are supported by Arc-
Cadastre. The model is divided into the following 
parts:

	 Quality

	 Properties

	 Plans

	 Buildings

	 Transport

A certain degree of extension and customization 
of the model is possible. As the functionality of 
the software is based on the contents and structure 
of the data model great care must be taken when 
changes are made to the model. Lantmäteriet will 
retain responsible for the model to ensure that all 
future modifications can be standardized for use by 
all users.

This model also has a number of general topo-
logical rules that are based on the rules that are 
defined in ArcGIS 9.2. 

The Basic Model  is object-oriented and is open 
for customization for use with a variety of areas of 
activity. This model contains some of the custom 
objects, which are of central importance for real 
property formation and map production.

The AutoKa model is geometry-oriented and 
cannot be customized. The main purpose of this 
model is to facilitate the handling of data to and 
from AutoKa’s transfer file format (FF). 

ArcCadastre comes with comprehensive de-
scriptions of the three data models and how to load 
data to a geodatabase.

There are also class diagrams based on the Unified 
Modeling Language (UML).  Making changes to 
these diagrams requires Visio software from Micro-
soft.

Survey databases
ArcCadastre is a unique solution that extends GIS 
functionality by adding survey functionality.  In 
ArcCadastre, a Survey database is an extension of 
the geodatabase for storing field survey data with 
links between the stored data and survey points and 
features.

As all existing survey data and the associated 
computations are stored in the survey database, 
you can easily, at any time, go back and recompute 
points with old data or use new data to update them 
and features.  In ArcCadastre there are data storage 
models and functions for handling survey meas-
urements including point attributes, such as point 
names and numbers, mean square errors, quality 
information, method of determination, reliability 
etc. The survey database is fully integrated with 
ArcCadastre.

Feature

Link

Survey point

Computation

Measurment

GIS-layer

Survey-layer
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rv

ey
 p

ro
je

ct

	 Land and water

	 Height and planimetric  
	 control networks

	 Fresh water and drains

	 Pipes and cables

	 Historic sites and remains
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Survey and computation 
ArcCadastre contains powerful tools for handling 
different kinds of measurements and computations 
including adjustment of triangulation and traverse 
networks, adjustment of leveling and height travers-
es and the computation of points fixed by polar or 
orthogonal methods. It is also possible to compute 
setting-out data and export it to field equipment for 
setting out details on the ground.  Survey observa-
tions can be imported and computed automatically.  
You can import measurements made in the field 
using for example a TPS into ArcCadastre. Survey 
points are created and updated from these measure-
ments through a set of computations.

Survey measurements are stored in a survey da-
tabase and measured points are linked to features in 
the geodatabase.  As observations of angles and dis-
tances are stored in ArcCadastre, points can always 
be computed when they are needed. Import and 
export between ArcCadastre and different types of 
survey instruments is done using a data converter. 

You can create your own data converter and 
code translator for import and export using COM-
programming.

Import and export
An important requirement in the development 
strategy for ArcCadastre was easy exchange of data 
with different GIS and CAD systems via different 
file formats.  ArcCadastre can handle the following 
formats: AutoKa Transfer File, DXF, DWG, MID/
MIF, DGN, MapInfo TAB, KF85 and ArcInfo 
(shape, coverage etc.). Other formats can be added 
by purchasing components from Safe Software Inc. 
Contact your software provider for more informa-
tion.

Import
Survey Data

COGO Plan Data Entry
3rd party
Instrument Data
Existing PlansMaps

Edit
Survey Data

Process
Survey Data

XYZ

Edit
Features

View Quality,
Reports
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ArcCadastre is based on COM technology and the 
international ISO and OGC standards. The system 
can easily communicate with service-oriented ap-
plications and external databases. This creates the 
opportunity of integrating the solution into host 
systems or control subordinate systems (e.g. auto-
mated creation of Office documents).

Customization
ArcCadastre is based on the Component Object 
Model (COM) which is a technique for communi-
cation between objects within the program and 
between other programs. By using this technique it 
makes it easy for both program developers and end-
users to extend and customize the software.  Using 
COM makes it possible to create reusable program 
components.  These components can be reused on a 
binary level, which means that there is no need for 
access to source code and object libraries to extend 
the system.  Any kind of tool that supports COM 
techniques, such as Visual Basic, Visual C++, C# or 
Delphi, can be used for developing components.

ArcCadastre comes with a plug-in wizard for 
Visual Basic programming. To facilitate program-
ming, the wizard contains a complete skeleton 
program with error management functions.  With 
the support of the wizard you can customize Arc-
Cadastre without having to be a fully accomplished 
Visual Basic programmer.

These features make ArcCadastre completely 
open for customization and use together with other 
programs.

Interacting with other software
ArcCadastre has been designed to be very flexible 
in its ability to work with other programs. Via the 
underlying COM-technology it provides simple and 
easily accessible interfaces that can be used in build-
ing communication solutions to other software.

Localization

User Customization

Business Adaptation

COM based software
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3
Getting Started with ArcCadastre - which 
contains the “Quick Start” tutorials.  Going 
systematically through these tutorials is the 
best way to learn how to use and under-
stand the fundamentals of ArcCadastre.  
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ArcCadastre can be started in one of the following 
ways:
From the Start menu:

1 	 From Windows Start button, select the pro- 
	 gram group ArcCadastre. 
2 	 Click on   ArcCadastre.

From ArcCadastre/FileManager (if the program is 
started):
1 	 In ArcCadastre/FileManager, click the       

 	  Launch ArcCadastre button. 

Starting ArcCadastre
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You can get help when you are working with ArcCa-
dastre in several different ways.  In addition to the 
comprehensive Online Help system in the program 
itself, you can also get help from the support organi-
zation that has been built up around ArcCadastre.  
For more information about getting help, please 
contact your software dealer.

You can access the built-in Help system in one 
of the following ways:

ToolTips
To find out what a button, tool or menu command 
does:

1 	 Place the mouse pointer over the item, but do 	
	 not click.  For a few seconds you will see a 	
	 short description. At the same time you will see 	
	 a fuller description in ArcCadastre’s status field 	
	 at the bottom of the program window.

Getting help
What’s This
Getting more help about buttons and menu com-
mands in the application window

1 	 Click the What’s This? button  on the       
 

 	
	 Standard toolbar. 
2 	 Click the Help pointer on the item you 		
	 want to learn more about. 
3 	 Click anywhere on the screen to close the Help 	

	 description box. 

Getting help about items in a dialog box

1 	 Click the What’s This? button on the             
	 upper-right corner of the dialog box. 
2 	 Click the Help pointer on the item you 		
	 want to learn more about. 
3 	 Click anywhere on the screen to close the Help 	

	 description box. 



22     ArcCadastre • Getting Started

Online Help

Using the Contents tab to get help

1 	 Click the Help menu and then click ArcCa-	
	 dastre Help. 
2 	 Click the Contents tab. 
3 	 Click the plus sign next to a book to see a list 	

	 of topics in it. 
4 	 Click the topic you want to read. 
5 	 View the topic in the topic pane on the right. 

Searching the Index for help

1 	 Click the Help menu and then click ArcCa-	
	 dastre Help. 
2 	 Click the Index tab. 
3 	 In the text box, type one or more keywords that 	

	 best represent the topic you are looking for. 
4 	 Double-click the keyword you want to read 	
	 more about. 
5 	 If several topics are related to your selection, the 	
	 Topics Found dialog box appears. Click the 	
	 topic you want to see and click Display.
6 	 View the topic in the topic pane on the right. 

Searching for Help topics containing specific 
words

1 	 Click the Help menu and click ArcCadastre 	
	 Help. 
2 	 Click the Search tab. 
3 	 Type the word or words that should be contain-	

	 ed in the topics you want to find. 

4 	 Click List Topics. 
5 	 Double-click the topic you want to read more 	
	 about. 
6 	 View the topic in the topic pane on the right. 

The word or words you specified are highlighted in 
the topic.

Searching for Help topics using wildcard ex-	pres-
sions

1 	 Click the Help menu and click ArcCadastre 	
	 Help.
2 	 Click the Search tab.
3 	 In the text box, type an expression using an 	

	 asterisk (*) to represent several characters or a 	
	 question mark (?) to represent one character. 
4 	 Click List Topics to see a list of topics matching 	
	 the query.
5 	 Double-click a topic in the list to view it in the 	
	 topic pane on the right.

	 The words resulting from the search query are 	
	 highlighted in the topic.

To get more information and tips for using the Help 
system, double-click on the text Getting Help. 



  Chapter 3 • Getting Started with ArcCadastre     23

Support
Should you need more help, please contact your 
software dealer.
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QuickStart tutorials

This chapter will take you through your first practi-
cal experience of working with ArcCadastre. You 
will do nine exercises and work with a Job called 
QuickStart. You will create this Job from a Job tem-
plate and then follow the workflow through to the 
completed printout. In the exercises you will learn 
how to use simple tools, such as how to zoom in and 
out on a map, as well as more advanced functions 
such as how to edit objects in the database. When 
you have completed the exercise you should have a 
general understanding of working with ArcCadastre 
and have familiarized yourself with some specific 
ArcCadastre concepts. 

To get the maximum benefit from later exer-
cises we strongly recommend that you carefully go 
through part 2,  ArcCadastre in detail, before you 
begin the exercises.

To do the exercises you must have ArcCadastre 
installed on your computer. If you need help doing 
an installation refer to the Readme.pdf on the Arc-
Cadastre program DVD.

Let’s get started
In the following exercises you will use different 
functions in ArcCadastre ranging from basic func-
tions such as zooming to more advanced functions 
such as editing and subdividing an existing prop-
erty and placing a building on the newly created 
property unit. You will follow a simple workflow in 
which you successively tick check boxes as individ-
ual tasks in the workflow are completed. The result 
of the exercises will be a map ready for printing.

Exercise 1 - Copying the data for the exer-
cise using ArcCadastre/FileManager
In the exercises that follow you will, amongst other 
things, edit the data and make changes to the con-
tents. So that you, or someone else, can repeat the 
exercises you must be able to copy the data to a fold-
er on your computer and retrieve it from that folder. 

1 	 Start ArcCadastre/FileManager from the  
	 Windows Start button.		            

 
  

	 Select the program group ArcCadastre and click 	
	 ArcCadastre/FileManager. 

ArcCadastre/FileManager will start and you will 
see the ArcCadastre/FileManager window divided 
into two panes on your screen. The catalog tree 
on the left pane of the ArcCadastre/FileManager 
window is for browsing and organizing your data. 
The contents of the current branch are displayed 
on the right pane of the ArcCadastre/FileManager 
window. If you want more information about the 
contents of the data, click the Contents, Preview 
and Metadata tabs.

2 	 In the catalog tree navigate to the folder in 	
	 which you installed ArcCadastre. The contents 	
	 of the folder are shown in the right pane.
3 	  In the right pane, right-click the folder called 	

	 QuickStart and select Copy.
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4 	 In the catalog tree right-click on C:\ and select 	
	 Paste.

If you don’t have access rights to C:\ you can paste 
the folder in another location. You will then have 
to browse for files in this location when doing the 
exercises.

You have now placed a copy of the folder called 
QuickStart on C:\. This is the folder that we mean 
when we refer to the QuickStart folder. All you 
need to do the exercises is in this folder.

Exercise 2 - Starting ArcCadastre
You will now start ArcCadastre. You can start the 
program in two different ways:

1 	 From ArcCadastre/FileManager (if the pro- 
	 gram is started):

	 Click the Launch ArcCadastre button        
	 on the upper row of buttons in ArcCadastre/	
	 FileManager.

	 From the Start menu:

1 	 Start ArcCadastre by clicking the    
	 Start button on the Windows taskbar. 
2 	 From the program group ArcCadastre, click on	
	 ArcCadastre.

ArcCadastre will start and you will see the Start 
dialog on your screen. Here you have the choice of 
starting ArcCadastre with no Job open, by creating 
a new Job or by opening an existing Job.

2 	 Click No Job open and then click OK.

You can now close ArcCadastre/FileManager.
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The ArcCadastre program window is now opened 
and in the upper part of the window you will see 
dropdown menus and buttons for functions and 
tools. The program window is divided into two 
panes. The pane to the left - the table of contents 
- lists all the layers in the map and shows what fea-
tures each layer represents. The pane to the right 
- the map window - contains the map that you have 
chosen to show. In the map window you can show 
the map in two different ways: Data View or Layout 
View. You should use the Data View when you are 
working with your data. With this option other 
map elements, such as north arrow, scale bar and 
others, will not be shown. You should use the Lay-
out View when you want to work with the layout 
or make a print out of your final map. In this mode 
the other map elements, for instance north arrows 
and scale bars, are shown. You will learn more about 
layout views in later exercises.

Exercise 3 - Creating a Job from a Job 
template
In this exercise you will create a Job from a pre-
defined Job template. Job templates are created 
by specialist customizers and they contain all the 
necessary settings for a specific type of Jobs, for in-
stance links to data and workflows. A Job is created 
from a Job template and is stored in a Job database.

Job database is a geodatabase enhanced with a 
data model for handling Jobs. You can have several 
Job databases for storing your Jobs. For example, 
you can have a local Job database on your own com-
puter, which only you can use, and you can have a 
connection to another Job database on a server to 
which several persons have access rights and can 
view or work with the same Job.

1 	 Click the button Create a New Job from 
	 a Template on the Job toolbar that 	
	 is used for managing Jobs. You will see 	
	 these buttons between the two panes.

The Create Job from a Template dia-
log is opened. You will see some of the 
Job templates that are available (it is 
also possible to browse to use other 
templates). If there is a description of 
the Job template it will be shown in 
the Description pane to the right. The 
Job template that you will use for this 
exercise is in the folder called Quick-
Start. You will now retrieve the Job 
template from the folder.
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2 	 Click the Open Folder button  . 
3 	 Click the Look in dropdown arrow and browse 	

	 to the folder C:\QuickStart\ Job Templates.  
	 Select the file called Quickstart.acejt and click 	
	 Open.

The Job Database Connections dialog is opened.

Note! If a Job database previously has been opened, 
the Job Database Connections dialog will not be 
opened automatically. You will instead see this dia-
log which shows all available Jobs in the previously 
opened Job database:

To continue, open the Job Database Connections 
dialog by clicking on the Connections button.

You will now open the Job database by creating a 
connection to your local Job database. This base is 
located in the folder QuickStart.

1 	 Type the name of your connection to the Job 	
	 database in the Name input field. In this exam-	
	 ple we will give it the name QuickStart Job  
	 Database.
2 	 Next to the Connection Properties field click 

  	 the browse button.		               
3 	 In the Databace connections dialog, click the 	

	 Look in dropdown arrow and browse to  
	 C:\QuickStart\My QuickStart Job Database.  
	 Select QuickStart Job Database.mdb and click 	
	 Select.
4 	 Click the button Add and a connection to your 	
	 Job database will be created.
5 	 Close the dialog.

The Create Job dialog is opened. 

6 	 In the Job Database Connection panel, select  	
	 QuickStart Job Database.

You have now created a connection to your local 
Job database and opened it. The next step is to give 
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the Job a name and, optionally, a short description. 
The description will be shown when you, or another 
user, open the Job.
1 	 In the Name of the new Job input field, type 	
	 e.g. QuickStart.
2 	 In the Brief Description of a new Job input 	
	 field, type a descriptive text, e.g.  Subdivision of	
	  a property and then create a new building Job. 
3 	 Click Create.

You have now created a new Job. Data is added in 
the map window, and you can see the layer structure 
for this data in the table of contents. A window that 
contains a workflow dialog is opened. You will learn 
more about this later in this exercise. If someone 
else has been working with the program you might 
not see the Workflow window. To display it, click 
the last button in the Job toolbar (Show/hide Work-
flow dialog). 

At the bottom of the table of contents there are a 
few tabs, the ones we will use in this exercise are 
Display, Source and Job.

   

Display  
The Display view shows the layers in each data 
frame sorted in drawing order. Layers at the top of 
the list are drawn on top of layers lower down in the 
list. You can drag and drop layers in the list to rear-
range the drawing order.

Source  
The Source view shows the data that is included in 
the Job. It shows where the data is located, for in-
stance paths to databases and other files. If there are 
tables in the Job they will be listed in this view (they 
are not visible in the Display view).
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Job  
The Job view shows the current settings for each 
Job. In this view, there is information about map 
documents, plotting styles, attached files and 
whether the Job is connected to or has its own sub-
Jobs. Under this tab you can also change the set-
tings for a Job. 

	 Take a moment to explore the tabs at the bot-	
	 tom of the table of contents.

When you do the remaining exercises you will 
follow a workflow. The workflow will help you 
to follow the working process. The simplest form 
of workflow is a set of check boxes in which you 
check the different steps in the process as they are 
completed. In more complex workflows it may be 
mandatory to carry out some operations in a given 
sequence, or in a specific way, before the process 
can continue. A workflow can contain macros and 
program loops, which automate steps in your work. 
Workflows are created by specialist customizers. 

If you want to learn more about workflows you can 
read the document Workflows.rtf. The document 
can be found in the folder Documentation where 
ArcCadastre is installed.

Approval of
application

Data collection

Properties 
involved

Add from 
local archive

Analyse
prerequisites

Reserv property
designation

Fieldwork prep

Cancel job [Application cancelled]

[Application approved, Registration completed]

Checking out completed 
 [Checked out from F-ADB]
 [Checked out from GDB]

Clients informed 
 [Call for meeting sent]
 [Client informed]
 [Documents prepared]

Checking out completed 
 [Check out from measure archive]

Checked [Plans and regulations, Leese, Mortgage]

Done [Reserved in FDS]
 [Reserved in F-ADB]
 [Reserved in Helas]

Continue [Measurements ordered]
 [Fieldsketch done]
 [Client informed]
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The workflow is opened in a dialog of its own which 
you can drag to a suitable position on your screen. 

In the Workflow Dialog you have an overview 
of the working process. In the upper panel you can 
see where you currently are in the process. If there 
are alternative ways to move forward to the next 
step you make your choice in the Transition drop-
down menu. In the Conditions pane you can see the 
requirements that must be satisfied before you can 
move forward through the workflow. When these 
requirements have been met, the button at the bot-
tom of the Workflow Dialog lights up. 

When you click the button the process takes you to 
the next State. In some cases the Transition takes 
place automatically. 
Whilst you are working with the workflow you can 
also view the workflow as a UML diagram. 

1 	 Click Show in the Workflow Dialog. 

2 	 Click Viewer and a new window is opened.

In the Viewer window you can see your workflow 
as a UML diagram. You can use the Viewer to get a 
general overview of the working process. Your cur-
rent position in the process is shown in red on the 
diagram. 
3 	 Close the Viewer window.

The workflow that is included in this exercise is a 
simple workflow in which you will check the vari-
ous steps as they are completed. 



  Chapter 3 • Getting Started with ArcCadastre     31

If you want to halt and close a Job to continue later, 
or to let someone else take over where you left off:

1 	 Click the button Close the Job that is currently 	
	 open on the Job toolbar between the        	
	 two panes.

The Job will be saved and closed. The next time 
you, or someone else, open the Job it will look ex-
actly as it was when it was closed. The workflow 
position will be the same, the map extent will be 
the same, the table of content will have the same 
content etc.

An existing Job is opened as follows:

1 	 Click the button Open an Existing Job     	
	 This button is on the Job toolbar between 	
	 the two panes.
2 	 The dialog Select a Job to Open opens.

Should you close the Workflow Dialog 
by mistake, or because of lack of space, 
you can always reopen it by clicking 
Show/hide Workflow Dialog on the Job 
toolbar.

All Jobs in the selected Job database are shown in 
the Existing Jobs pane.

4 	 Select the Job you want to open in the Existing 	
	 Job pane.
5 	 Click Open.

You have now created your first Job in ArcCadastre 
and are ready to do the next exercise. Before you can 
continue you must check the steps that you have 
just completed in the workflow checklist located in 
the Workflow Dialog. 

1 	 Click the Job Created check box.

When all conditions are completed it is possible to 
continue and the button at the bottom of the dialog 
is now enabled. You can now continue to the next 
State by clicking the button Next Exercise, Change 
Plotting Style.
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2 	 Click the Next Exercise, Change Plotting Style 	
	 button.

You are now ready to go on to the next exercise in 
which you will continue through the working proc-
ess.

Exercise 4 - Changing Plotting Style
In this exercise you will add a plotting style for your 
map. ArcCadastre uses plotting styles to define 
how the presentation of data is to be done either on 
screen or on a printer. A plotting style consists of 
a number of layer names with descriptions of how 
each layer is to be drawn. The plotting layer descrip-
tions can be for drawing points, lines, polygons or 
text. Because a plotting style does not contain any 
information about data sources, you can use the 
same plotting style for different data sources. This 
makes it possible for an organization to build up a 
library containing ready-to-use plotting styles that 
can be used by several users. The great advantage 
of using a plotting style is that you can easily and 
quickly change the appearance of a map. For exam-
ple, you can use one plotting style for editing a map 
and a second for presentation. You can see which 
plotting style is currently active on the row under 
Layers in the table of contents (when the Display 
tab is highlighted).

1 	 Click the Job tab at the bottom of the table of  
	 contents. The settings for your Job will be 	
	 shown. 
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2 	 Right-click PlottingStyles and then click Add 	
	 Plotting style.

3 	 Click the Look in dropdown arrow and browse 	
	 to C:\QuickStart\Plottingstyles.
4 	 Select QuickStart.pstyle.

You now have two different alternatives for add-
ing plotting styles to a Job. You have the option of 
either saving a copy of the plotting style in the Job 
database or saving a link to the file. The advantage 
of saving a link to a file is that you only need to 
save the plotting style in one place, which can then 
be accessed by all users. Furthermore, when the 
plotting styles are updated or changed, all of the 

changes will automatically be made the next time 
the Job is opened. If you choose to save a copy of 
the plotting style in the Job database the link to the 
original plotting style will be removed and it can 
only be modified from within the Job.

6 	 At the bottom of the dialog, click the alterna- 
	 tive Save a link to the file in the Job Database.
7 	 Click Open.

You have now added the plotting style to your Job.

 8 	 Click the plus sign to the left of Plotting Styles. 	
	 The tree structure expands and you see the 	
	 plotting style that has been added to your Job.

You have now completed another step in your work-
flow.

9 	 Check the Plotting Style Added check box in 	
	 the Workflow Dialog to show that this step has 	
	 been completed. 

You will now change to the plotting style that you 
have just added to your Job.

1 	 Change to the Display view again by clicking	
	 the Display tab at the bottom of the table of 	
	 contents.
2 	 Right-click New Plotting Style (the line below 	
	 Layers in the table of contents).
3 	 Click Change Plotting Style.
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4 	 In the Change Plotting Style dialog choose 	
	 Quickstart.pstyle.
5 	 Click Change.

Select not to save the plotting style if prompted.
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The map is redrawn with the new plotting style.

You can also change to a plotting style that is not 
in the Job. Choose Change Plotting Style as above 
and, instead of selecting it from a list, browse to the 
plotting style and select it.

You have now completed this exercise and are ready 
to continue to the next one, Explore ArcCadastre.
1 	 Click the Plotting Style Changed check box in 	
	 the Workflow Dialog.
2 	 Click the Next exercise, Explore ArcCadastre 	
	 button.
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Exercise 5 - Exploring ArcCadastre
You have now created a Job and added map data to 
it and are ready to look more closely at the program 
itself and its tools and functions. In this exercise you 
will learn how to use some of the basic functions in 
ArcCadastre. These functions are common to both 
ArcCadastre and several other programs, so if you 
have previously used any of them you can treat this 
section as a refresher.

In the upper part of the ArcCadastre’s program 
window you will see dropdown menus and buttons 
that contain tools and functions. Take a few min-
utes to look at the contents of the dropdown menus 
at the top of the program window.

In ArcCadastre there are many ways of finding 
a wide range of information that you will find use-
ful in different situations. You will now get to know 
about and use some of them.

On the Tools toolbar there are several tools that 
you will find useful for navigating on maps.

1 	 Click the Zoom In button 

The pointer will change to a magnifying glass 	
	 when you move the cursor over the map.
2 	 Click and create a frame around an area on the 	
	 map.

You will now have zoomed in on the area you chose. 
If you want to zoom in further, all you need to do 
is click again and create a new frame. You can also 
zoom in steps by repeatedly clicking in the map 
window.

You can use the Zoom Out button  in the 
same way as Zoom In. You use the panning tool 
if you want to move around in the map without 
zooming.
3 	 Click the Pan button 

4 	 The pointer will change to a hand when you 
move the cursor over the map. Click, hold the but-
ton depressed, and pan over the map.
5 	 Release the mouse button when you are satis-	
	 fied.

To undo zooming or panning and return to the pre-
vious extent, use the Go Back To Previous Extent 
button.
6 	 Click the Go Back To Previous  
	 Extent button. 		           

In a similar way, you can click the Go To   
Next Extent button  to move forward a      
step through the sequence of extents you  
have been browsing. 

You have now learnt how to use some of the zoom  
functions in ArcCadastre and can now check the 
box for this step in the workflow.

1 	 Click the Zoom check box in the Workflow 	
	 Dialog. 

You can also set the scale for your map either by 
typing a scale value or by selecting one of the fixed 
values in the Scale dropdown menu in the upper 
part of the program window. 

1 	 Click in the Map Scale dropdown menu (the 	
	 text will be highlighted in blue.
2 	 Type 2000 and press Enter. 

Your map will be redrawn at the scale you selected.

Another step in the workflow has been completed, 
check it in the list.

1 	 Click the Scale check box in the Workflow Dia-	
	 log.
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To get more information about a feature in the map 
you can for instance use the Identify tool.

1 	 Click the Identify button  on the Tools 	
	 toolbar.
2 	 Click on a feature on the map.

The Identify window opens. In this window all of 
selected feature’s attributes and relations to other 
features are shown. If the tool finds several features 
at the point where you click, they will all be listed 
in the left pane of the window. If you then click a 
feature in the list you will see the attributes and re-
lations in the right pane.

3 	 Close the window Identify window.

You have now almost reached the end of this exer-
cise.

1 	 Click the Identify check box in the Workflow 	
	 Dialog.

If you have zoomed in on your map and now want 
to see the whole map, you can rapidly zoom out to 
the full extent. 

2 	 Click the Zoom to Full Extent button  
 
You have now checked all of the items in the check-
list for this exercise and are ready to start the next.

3 	 Click Next Exercise, Editing in ArcCadastre, in 	
	 the Workflow Dialog.
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Exercise 6 - Editing with ArcCadastre
You have now created a Job and learnt how to use 
some of the basic functions in ArcCadastre. In this 
exercise you will begin to use your map data, create 
new features and edit existing ones.

ArcCadastre contains an editor, which has 
several functions and tools that you will find useful 
when you are working with map data. In this exer-
cise you will only use a few of them, but as they are 
all used in a fairly similar way you will get a good 
idea of how to work with them. Try using some 
of the other tools when you get to the end of these 
exercises.

1 	 Click the Editor Toolbar button  on the 	
	 ArcCadastre standard toolbar.

The Editor toolbar opens. In this mode all buttons 
and dropdown menus are dimmed. Before you can 
start editing you must start the Editor.
2 	 Click Editor on the Editor toolbar and then 	
	 click Start Editing.

You are now in the editing mode and will see that 
the buttons and dropdown menus are active and 
can be used for editing. 

You use the Editor in the following way. In the Task 
dropdown list, choose the function that you want to 
implement, for example, Create New Feature. If you 
browse through the list you will see that there are 
several functions to choose from. 

The type of feature you create is steered by the set-
ting in the Target dropdown list. This list contains 
the names of all of the layers in the datasets with 
which you are working, together with all existing 
Subtypes. For instance, if you set the target layer to 
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Land Use: Open Area, any features you create will 
have the Subtype OpenArea in the Land Use layer.
The Sketch Tool is the main tool for creating 
sketches. To create a point feature, click once on 
the map. To create line or polygon features, use the 
Sketch tool to digitize the vertices that make up 
the feature. To create the last vertex and finish the 
sketch, double-click mouse or right-click and select 
Finish sketch. After you have finished the sketch, 
ArcCadastre will create the final segment of the 
sketch to build a feature.

When you are in the editing mode  
you can use the Undo and Redo buttons  
to undo or redo the last command or action. You 
cannot, however, undo or redo anything you did in 
the editing mode once you have saved your edits.  

In the next part of this exercise you will first divide 
a property into two equal parts and then place a 
new building on the newly created unit by digitiz-
ing.

1 	 Use the Zoom tool that you learnt to use in Ex-	
	 ercise 5 to zoom in on the property Norrviken 	
	 1:1, which lies west of the lake in the southwest 	
	 part of the map.

You will now use the Cut Polygon Using Area/
Length Constraint tool to divide the property into 
two equal parts. 
On the Editor toolbar:

1 	 Click the Task dropdown arrow and choose 	
	 Cut Polygon using Area/Length constraint.
2 	 In the Target dropdown list choose 		
	 Parcel.
3 	 Click the Edit tool  .

The pointer will now look like the figure on the 
Edit button.

To be able to select features from the Parcel layer 
you must make settings for the interactive selection 
tools. These settings can be done automatically 
but in this exercise you will learn how to manually 
make the settings.
4 	 On the Selection menu, select Set Selectable 	
	 Layers.
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The Set Selectable Layers dialog will be shown on 
your screen.

5 	 In the dialog, click the Clear All button to un- 
	 check all layers.
6 	 Click the Parcel check box.
7 	 Click Close.
8 	 Click on the property that you zoomed in on 	
	 earlier in the exercise. 

The property will be highlighted in blue.

1 	 Click the Sketch tool  on the Editor tool-	
	 bar. 

The pointer will look like this . You will now 
create a line which will divide the property into two 
parts.

2 	 Click and digitize the first point on the line just 	
	 outside the existing boundary at the north side 	
	 of the property. 
3 	 Right-click on the boundary on the eastern side 	

	 of the property. In the menu click Parallel. 

A line will be created parallel to the boundary on 
which you right-clicked.
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4 	 Click to digitize a second point just outside the 	
	 property boundary at the southern side of the 	
	 property.

5 	 Right-click and then choose Finish Sketch.

The Cut Polygon using Area/Length constraint 
dialog is opened: 

You will now use this tool to divide the property 
into two equal parts by defining the area of the 
newly created unit to the left as 50 % of the total 
area of the original property.

In the Constrain panel:
6 	 Type 50 in the middle field. 

7 	 Click the dropdown arrow to the right and 	
	 change the value in the dropdown list to % of 	
	 total area.

8 	 Click Refresh in the bottom corner of the dia-	
	 log.
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Next to the line you digitized there will now be 
a line with a black arrow which shows where the 
property will be divided in accordance with the val-
ues you entered.

9 	 Click OK to confirm the values for the division.

The original single property will be redrawn as two 
new units with exactly the same area. 

The next step is to give the newly created property a 
new designation.

1 	 Click the Attributes tool on the Editor 
 
	

	 tool bar.  

The Attributes window opens and you can now in-
spect and modify attributes for selected features.  

The selected features and their identities are shown 
in the left pane. When you click on one of the fea-
tures in the list you will see its attributes in the right 
pane.

2 	 In the left pane click the first of the two selected 	
	 features.
3 	 You will now enter the new designation, in this 	

	 exercise this is done in the field Designation. 	
	 Click to the right of this field (i.e. in the Value 	
	 column).

	

	
4 	 Type 1:21 and press Enter.
5 	 Close the Attributes window.
6 	 Check the Property divided check box in the   	
	 Workflow Dialog window.

You have now completed the first part of this ex-
ercise and have divided the property into two new 
units of exactly the same size. 
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1 	 Check the Property divided check box in the 	
	 Workflow Dialog window.

You will now place a building on the new property 
by construction.

On the Editor toolbar:

1 	 Click the Task dropdown arrow and choose 	
	 Create New Feature in the list.
2 	 In the Target dropdown list choose Building.

You will now place the building on the new prop-
erty unit Norrviken 1:21. It is to be located 6 meters 
from the north-west corner, 23 meters from the 
north-east corner and the size of the building is to 
be 9 x 15 meters.

Before you begin to create the building you must 
specify settings for snapping so that you can snap to 
the property boundaries. 

3 	 Click Editor on the Editor toolbar and then 	
	 click Snapping.

The Snapping Environment dialog is opened. You 
make the snapping settings by checking the respec-
tive check boxes. 
There are three snapping options for each layer: 
Vertex, Edge and End. Vertex snapping snaps to the 
vertices of features. Edge snapping snaps to any part 
of the lines in the layer and is not affected by verti-
ces. End snapping snaps to the endpoints of lines. 

In this part of the exercise you will snap to vertices 
in the Parcel layer.

4 	 Click to check the Vertex check box for the Par-	
	 cel layer (as in the previous picture).
5 	 Close the Snapping Environment window.

You will now create the first corner of the building.
1 	 Use the Zoom In tool to zoom in the property 	
	 some additional steps.
2 	 Click the Sketch tools dropdown arrow and 	
	 then the Distance-Distance tool.
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3 	 Create the first vertex by entering the distance 	
	 from the parcels upper left and right corners. 	
	 Move the pointer towards the north-west cor-	
	 ner of the property.  As you move the pointer 	
	 closer to the corner, the circle in the pointer 	
	 moves automatically and snaps to the intended 	
	 position.
4 	 Left-click on the “corner”.

As you move the pointer away from the corner a cir-
cle appears the radius of which is the distance from 
the corner.

5 	 Press the D key on your keyboard.
6 	 Type 6  in the Distance dialog that appears on 	
	 the screen, and press Enter.

	

7 	 Move the pointer towards the north-east corner 	
	 of the property and click in the corner.

8 	 Press the D key on your keyboard.

9 	 Type 23 in the Distance dialog box and press 	
	 Enter.

10 	 Left-click the lower of the two circle intersec-	
	 tions.

The first corner of the building has now been cre-
ated. 

The longest side of the building is to be parallel to 
the western boundary of the property.

1 	 Click the Sketch tools dropdown arrow on the 	
	 Editor toolbar and then the Pen tool.   

 
  

2 	 Place the pointer over the western property 	
	 boundary and right-click .
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3 	 In the menu, click Parallel. The line will now be 	
	 drawn parallel to the property boundary.

4 	 Right-click and choose Length.
5 	 Type 15 in the field of the Length dialog box 	
	 and press Enter.

	

You will now make sure that the first corner of the 
building is right angular.

1 	 Right-click and choose Deflection. 

2 	 The Deflection Angle dialog appears on your 	
	 screen.
3 	 Type 90 in the field and press Enter. 
4 	 Right-click and choose Length.
5 	 Type 9 in the field and press Enter.

Complete the construction of the building by creat-
ing two sides that are exactly the same as the two 
that you have already created.

6 	 Right-click and choose Square and Finish.
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You have now almost reached the end of Exercise 6, 
and are ready to begin the next exercise in which you 
will create a layout.

5 	 Click the Zoom to Full Extent button  to 	
	 zoom to the full extent of the map.

In the Workflow Dialog:

1 	 Click the Building digitized check box.
2 	 Click the Next Exercise, Create Layout button.

ArcCadastre automatically creates the last two sides, 
perpendicular to the previous two to finish the con-
struction of the building.

You have now divided an existing property into two 
parts and on one of them you have placed a building 
by digitizing. To save the changes you have made 
you must now end the editing session.

1 	 Click Editor on the Edit toolbar.
2 	 Click Stop Editing. 

3 	 Answer Yes when asked if you want to save your 	
	 changes.
4 	 To redraw your map,  
	 click the Refresh View  
	 button  , at the bottom  
	 of the map window.
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Exercise 7 - Creating a layout from an  
existing template
If you plan to create a series of maps and it is impor-
tant that they have the same appearance, you can 
use a map template to standardize the layout. If the 
series contains the same background data, you can 
include that data in the template. Using a template 
saves time, as you do not have to manually repeat 
the production of the common parts of the maps. 
ArcCadastre contains a number of ready-to-use 
templates and you can easily make your own tem-
plates.

In this exercise you will use an existing template 
to create a layout at a scale of 1: 3000, which will 
be ready to use for an A4 printout. The template, 
which is in the QuickStart folder, contains settings 
that steer paper size, frames, legend and more. In-
stead of working in the Data view you will now use 
the Layout view. 

You switch between views using the buttons at 
the bottom of the map window.

	

1 	 Click the Layout View button 

The Map window changes to the Layout mode and 
you will see your map on a virtual sheet. The data 
that you previously worked with in the Data view is 
now shown as a data frame on the virtual sheet. You 
now also have access to a new toolbar.

These tools can be used to change the size and posi-
tion of the virtual sheet. The Zoom in and Zoom 
out buttons are now used for zooming in the virtual 
sheet, not the map data itself. There is also a tool for 
changing layout template. 

2 	 Click the Zoom In button 
3 	 The pointer changes to a magnifying glass.
4 	 Click and create a frame around an area on the 	
	 virtual sheet.

The sheet will zoom in to the area you selected. If 
you want to zoom in more, click and create a new 
frame on the virtual sheet. Try using the other but-
tons to see what you can do with them.

5 	 Click the Zoom Whole Page button   
	 to view the full extent of the sheet.

You can also use the buttons on the Tools toolbar to 
change the extent of the map in the data frame. 

Now you will load a ready-to-use layout template 
for your map.

1 	 Click the Change Layout button  on the 	
	 Layout toolbar.
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The Select Template dialog opens. 

You can now retrieve the template from the Quick-
Start folder.

2 	 Click the Open Folder button  
3 	 Click the Look in dropdown arrow and navi-	

	 gate to C:\QuickStart\Layout Templates. Select 	
	 Quickstart.mxt and click Open.
4 	 In the Data Frame Order dialog click Finish.

The new layout template is added and is drawn on 
your screen. 
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Finally, you will set the scale for your map in the 
data frame. Enter the scale as you did in Exercise 5 
by typing the scale value in the Scale dropdown list 
field. 

5 	 Click in the Map Scale field and it will be high	
	 lighted in blue.
6 	 Type 3000 and press Enter.

The map in the data frame on the virtual sheet will 
be redrawn at the scale that you set.
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You have now learnt how to use a ready-to-use lay-
out template to create a map for printing. Having 
several layout templates ready for use means that 
you can quickly and easily create uniform sets of 
maps for printing.

1 	 Click the Map Template Changed check box in 	
	 the Workflow Dialog window.

Before you make a printout of your map you add a 
name and date to the layout. This has already been 
prepared and included in the Layout template.

1 	 On the virtual sheet, double-click the text 	
	 string, <Double-click to enter map title>.

2 	 In the Properties dialog, enter a name for the 	
	 map in the Text field in the Text tab. You can 	
	 for instance write the new property that was 	
	 created in the exercise: Norrviken 1:21.
3 	 Click OK.

4 	 The name of the map is now shown on the vir-	
	 tual sheet.

5 	 Repeat this step, but this time fill in the name 	
	 and the date by double-clicking on the two text 	
	 strings <Double-click to enter name> and 	
	 <Double-click to enter date> respectively.
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You have finished creating a layout using a layout 
template and the map is ready for printing.

In the Workflow Dialog:

1 	 Click the Text Added check box.
2 	 Click the Next Exercise, Print button.



52     ArcCadastre • Getting Started

Exercise 8 - Printing
In ArcCadastre it is easy to make a printout of a 
map.

1 	 In the File menu click Print.  
	 You can also click the Print button in the  	
	 upper part of the program window.
2 	 The Print dialog opens and the options avail-	
	 able depends on the selected printer.

3 	 If necessary, change options for page orienta-	
	 tion etc. 
4 	 Click OK to start printing.

You have printed out your map and are now almost 
at the end of these exercises.

1 	 Click the Print check box in the Workflow dia-	
	 log.
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If you want to complete the exercises and finish 
your Job:

1 	  In the Workflow Dialog select To End in the 	
	 Transition dropdown menu.
2 	 Click the Exercise Completed button at the bot	
	 tom of the Workflow Dialog.

3 	 Click OK in the Information box that comes up 	
	 on your screen.

NOTE:  When you have clicked the button Ex-
ercise Completed, the Job is finished and can no 
longer be changed. Create a new Job if you want 
to repeat these exercises.

Exercise 9 - Closing ArcCadastre 
Before finishing the exercises you might want to 
repeat or take another look at some of the exer-
cises. You can start all over again from the exercise 
Change Plotting Style.  The workflow will move 
back to the Change Plotting Style exercise and you 
can go through the exercises again. Note, however, 
that even though you have already done all of the 
exercise in this Job once, and all of the conditions 
in them have been satisfied (check boxes have been 
checked), you can still follow the instructions if you 
want to familiarize yourself more with the tools.

To start again from Exercise 4, Change Plotting 
Style:

In the Workflow Dialog:
1 	 Click the Transition dropdown arrow and select 	
	 Repeat Exercises. 

2 	 Click the Repeat button.
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You have now completed your first Job and followed 
a workflow through the full working process. We 
hope that this has given you an insight into how to 
work with the program. You have also tried using a 
number of functions and we hope that you now feel 
confident enough to begin exploring other parts of 
the program on your own. If you need help, there is 
a wealth of detailed information in the ArcCadastre 
Help system. To get help, press the F1 key or click 
the Help menu and choose ArcCadastre Help.

If you want to close the Job:

1 	 Click the button Close the Job that is currently 	
	 open in

    
the Job toolbar between the two 	

	 panes.

If you want to close the Job and ArcCadastre

2 	 Click the File menu and then Close Job and 	
	 Exit Application.
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Notes
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